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This marking on the product or on its
packaging illustrates that, under European
Directive 2012/19/EU governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation in national take-back initiatives
and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and related
packaging material) in accordance with all
Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling

program please visit: http://www.philips.
com/sites/philipsglobal/about/sustainability/
ourenvironment/productrecyclingservices.page.
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Main menu Sub menu
— Input — VGA
— DVI (available for selective models)
— HDMI (available for selective models)
— MHL-HDMI (available for selective models)
— Picture r— Picture Format —— Wide Screen, 4:3
— Brightness — 0~100
— Contrast — 0~100
— SmartKolor — On, Off
— SmartTxt — On, Off
— SmartResponse —— Off, Fast, Faster, Fastest
— SmartContrast — On, Off
— Gamma — 18,20,22,24,26
— Pixel Orbiting — On, Off
L— Over Scan — On, Off
(available for selective models)
— Audio Volume — 0~100

sRGB
User Define

— Color E Color Temperature

— Language

Suomi, Tiirkge,

— OSD Settings — Horizontal —
— Vertical —
Transparency —

— OSD Time Out —

— Setup — Auto

H.Position —
V.Position -
— Phase —
— Clock —
— Resolution Notification —

— Reset J—

L— Information

Mute — On,
(available for selective models)

(available for selective models)

Off

5000K, 6500K, 7500K,
8200K, 9300K, 11500K

Red: 0~100
Green: 0~100
Blue: 0~100

English, Deutsch, Espafiol, EMnvikn, Francais,
Italiano, Maryar, Nederlands, Portugués,
Portugués do Brazil, Polski,

Cestina, Vipaikcoka, IR,
Fiidst, BAGH, wheol

Pycckuin Svenska,

0~100

0~100

Off, 1,2,3,4

5s, 10s, 20s, 30s, 60s

0~100
0~100
0~100
0~100
On, Off
Yes, No

B 2B

AT, R Ra L A 7 HEE 1920
x 1080 @ 60 Hz WM feffE. B RasLIA
[ R TFEHU B 2 Rl
Use 1920 X 1080 @ 60 Hz for best results (&
ISB AR, FEAEH] 1920 x 1080 @ 60
Hz) &
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PHILIPS wwow philps comiwelcome
Resared s Monitor driver and software installation
f— Spcen reremens:
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Sytem support and reqremencs:
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Wizard

Adjust Preferences
Audo
Color Auto Pivot

Options ‘Theft Deterrence
Muki Montors

Help Start Weard
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Adjust (%) ¥

SR LAR ] Adjust (TR 38) 32 5ok iR
F%Brightness (,JL)\ Contrast (%t
F£)~ Focus (R £E) Position (7 ) Al
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SmartControl Premium

e
Brghtness

B
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Options

Help
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SmartControl Premium
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Options

Help
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SmartControl Premium

Brightness
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Options
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Help
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Brightness
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undo I
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Contrast
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Position

Use the Position buttons to center the image on
Your display. Using ths tool, you can postion the image
up, down, lef, or rght.

1. Use the Up/Down buttons to center the mage

Adjust verticaly.
2. Use the Lefy/Right buttons to center the image
horgonta.

srgtness
Color
. Contrast
\g Focus
Eco
o Podtion
undo Reset:
Resoliton
Options
Help
B smartcontrol @y

SmartControl Premium PHILIPS

Resolution

You are currently 3t  Preferred resolution. For your
dsplay to show ar ext, colors, and mages,
your dispiy shouid be sef to s Preferred resolution.

I your dipiy i at a Non-Preferred resolutin, clck
on th Preferred button to change your resokition to

T~ Enabe Resolution Notfier
Brghtress Picture Format
I~ 43 aspect ratio

Contrast.
AR
Focus

Postion
Prefered

Resolution

i ‘HHWHHHH“‘HH‘”NH“HHHH”H‘

Color (Bifa ) 38

AT LUR]H] Color (Bif) 25 F i 24
RGB. Black Level (FEZL5]). White
Point (1 #i)~ Color Calibration (i
ERUE). LA Smartimage (IF5 L
Smartimage —T7)

T AT DA% R 3 Ul AT T
WRAEHA, Z IR .
Color Calibration (il A HE) 7151«

12

W smartcontiol

Vi)

SmartControl Premium PHILIPS

Adjust

Options

Help

8 smartcontol

RGB
Al displayed colors are produced by miing Red, Blue,

i

the dsplayed colors,

o S 08
S o
Display Gamma o O
-
@p
=

2%

SmartControl Premium PHILIPS

Adjust

Options

Help

1 smartcontol

White Point
White Point is the pon at which equal combiations.
of red, green, and blue Ight at ul nensity create
whie. This effects the overal cobr quaky. For the
most accurate colors cick the Reset button then
select the White Poni

1. Please select the Whie Pont value for the best

posshle color qualty.

RGB
Black Level

Whie Point

wihte pont as00€

Diply Garra =) © W
LA

Galbraton

ap

Smartimage

Undo. Reset.

2%

SmartControl Premium PHILIPS

Adjust

Display Gamma

‘Gamma i 2 component of the pixel brightness in 3
dplay. A lower Gamma value produces brighter pixels
and a higher Gamma value produces darker pixels. The
default value for Gamma s 2.2.

To adjust Gamma, Smartimage must be set to Off.
Cick the Smartimage OFf butcon before adjustng

Gama
53 1. Use the sider to select the desred Gamma.
Back Level
i Dsplay Gamra 22
o O &
Dspy Garrra Smartimage Off
LA
tndo Reset
Galbratin W— e—
@p
smartimage
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SmartControl Premium

Adjust
RG8

e k.2

xg 2.
2

Eco Dispiay Gamma.
5 n\!fmn
ap
Options Smartimage
Help

e

PHILIPS

Calibration

p n the p mermber ime
o ek b oments o rage sy
whenever you move your dpiay to 3 new locatir

1. Make al other nacessary adjustments to mage

qualty frst.
2. Press Show Me to leam how to use the
tion ook
3. Finaly, press Start to begin the calibration

nable color cabrat
mr sftare Sesaned  colaboaton weh Joseoh

Potacted by U, Patent 1. 6,666,953

Show Me start

Quick View.

“Show Me (IH7R)” A SRR HESL

o

Start(JT4f) - A 3h 6 DEEAHERL T .

Quick View (PUEAF) N 11/ 2 J5 1

SIS

WZER A Color (BR) Tk, TTLLH

i Cancel ()44

Enable Color Calibration (Jii FHER a5
1) - FEBRAE L NI e o A,

WA SEVFRAT B EACHE, Start (JT46) AN

Quick View (PRLid £ ) F AR 1 .

ASHE i L6 20

E—IHBERERE

1E BRSO Z AT, Previous (

M A

Next (N —MIENJFHEK HAR (6 AH

BR) o

B ERIEE .

I J5 %% ) File > Presets pane (3Cf1>

TRBE) T o

« Cancel (W) P S, FFigE]
Plug-in (fifF) T,

Smartlmage

FEVE AR A 25 B 500 B AAS 2 T4 )

BRBE

MBCE BRI, JHH] SmartContrast il

SmartResponse,

B smartControl @9

SmartControl Premium PHILIPS

Smartimage
- smttmaga vt dFrnt Highines
ot i ot iy e g of
At 7
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\g W
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Xg whte Port
&l Deply Carra
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Photo. Movie
Help Economy Game.

ECO k&
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SmartControl Premium PHILIPS

Schedule Power Savings

L TR
n this pane to
e th poees s Guig o
P Timers
Adiust e Tamer - Useme i Bk i o)

oo ey restre the desop.

Power ff Times - Aftrthe diply enters stanchy
ce, e Power ffTier egrs o court: dow
adjust the

v ength of tive
btor the ﬂsn\avszu o e o, e
(once the d ower button must be
bressed o um the msvlay tecen
I ' schedule Daiy Poy
|selctthe cme an o o e dipay to Power Off
\m 00 =] T Monday I Tuesday I~ Wednesday
I Thursday I™ Friday
I saturday I~ Sunday

inel Savings

Schedule gowev Savngs.

1dle never

=0 &
Power Off 0 minute
=0 7

Help Standby Now Tum Power Off Now
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Theft Deterrence

]
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\g Audo
Color Auto Prot
\ -
\g xxxxx
Eco waard
0 i
2
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Options mgké!\l wwwww

WNZE 5 F Theft Deterrence (B ), AILLE
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{24 M\ Options (BT ) "R g ik

“Preferences (LT )” Ao AEASE

Fr B es (GZFF DDC/ICD |, A7 Help

(#51h) 1 Option( 3L ) kr2Enl H .

14

8 Smartcontrol 2%

SmartControl Premium PHILIPS

R E TR

e IR HER 5 H U fiE o
T AT .
TEBREGL T, I OT ) Sl B
Enable Context Menu (Jit H I~ 338
L), Enable Context Menu (JHH I F
SCHEEOTESL AT B R SO R
SmartControl Premium [#]Select Preset (
TEPE TR AE) I Tune Display (W4 21%)
MIELT. 2B bR S b R
SmartControl Premiums

TEBRASOLS, &P (JTJ3) Enable

Task Tray (it FIAE45 4G4 EIFR . Enable
Context Menu (Ji H | F 380 BoR
SmartControl Premium 4T 4540450
oo AT SATR KRR, WOR
Help (#fBh). Technical Support(iARZ
FRZEHLIET, Check for Update (7%
BB About (R T)AI Exit (1B H). 4
25 “Enable Task Tray (JA FIT454C4L)”
B, ATSFEAE B bRk U RExit GRH).
EERAN LT, & (FE) Run

at Startup (JAZIINIEIT). %k

I, SmartControl Premium £F )i 2l I5f
ANIEST, WMAEAESIERY . Ha)
SmartControl Premium [1ME— 7 &
SETARSE 7 N7 S0 Akt
HE CEERD I, A INBR S A 7R )E 8)
I AT 1) Pl B

A HE A (Windows 7/Vista/XP). Bk
IME S 0% NI

SIBHEAT



Options>Input (LI > HIN ) - ({49 Option>Auto Pivot (IR > BE1H &)

Options( JETN ) 732 HL oL £ Input( i\ ) s 2x
Hﬂ' Fl”ﬂ ° (+Z<3'Z*# D/JEIAZT?%% (32% DDC/ SmartControl Premium PHILIPS

Ch ., HA Help (#i8)) 1 Option( %I )
br&nH . B HAh SmartControl Premium

Ay -
bR ATT e -
8 Smartconrol ity ,moma
SmartControl Premium PHILIPS Cobr M!im
Tnput \g -
Dot
< 13
2 i Eco Wizard
Adjust Preferences = i . E
P
Audio 6
! Options Theft Deterrence
Color Auto Phot o
ok Honers

B
e i

Help

Help (%8 x8

g
g
.
5

®iw

"8 Help>User Manual ( #581 > APt ) - X
ML Help (#Bh ) S A IESE User
= ST =T Manual ( I FME) BT FEASCREM 2
_ o - e (CFEDDC/CD b, HAT Help (F50h)
«  IRSource (i AR A8 U BH A% FIY H Option( 355 ) k251 H .
TR A JR B T 2
o AERANRARRE, ANBIRICE SmartControl Premium PHILIPS

Options>Audio (JETN > & ) - 1M
Options (&I ) T hr ik Audio (& 41)

User Manual

erating SmartControl,
1 have the

INCIDEE o e
HEARLEM SRS Gk DDOCH k, H =4 |
T ~ b
A Help (#h ) Al Option( &5 ) k45 AI - x »
e p— D \g
SmartControl Premium PHILIPS Eco DMW
udio ¥
< 5 grated loudspeakers by checking the Clhis
Adiust E 2 g
"
- Help. User Manual Tech. Support
Color Auto Pivot.

Help>Version(#5 B > AR ) - 14 M Help (¥

Bh) Nh LSS Version A AT H .
i 2 EASCFEI WoRgs Gk DDCICD |, K

\g 45 Help (%58 ) 1 Option( XE5 ) bF2 T H .

R iv i

‘Options. Theft Deterrence
- o Voume 100
M Honors = +
e tndo
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8 Smartcontrol 2%

SmartControl Premium PHILIPS

Version

EVALUATION deune-plp-R2009-42-47-

ton: Yes - PDI APD

Copyrght © 1993-2009 Portrat Dispays, Inc.

Context Sensitive menu ( L T3 REKZEER )

Context Sensitive menu (= F 30Kk

S TEERAE DL MU H . SRR
Options>Preferences ( #il > FELL ) it
Fi%H T Enable Context Menu ( Ji R3¢
), K RIRIZGER.

G SmartControl Fremm

Select Preset
Tune Display
ower Saver

Economy

Context Menu ( L X B )F 441 H:

*  SmartControl Premium - *qIE$ERT, I
7~ About (T) B Fie o

*  Select Preset (IE1ZTIZMH) - 2t CIRAE
R PRBAEI )2 e o, IR Sl B ] LA
SERMTTH . SRk e 2 M i SR i i
WA . BbAh, AT LU R R s i H
Factory Preset (‘I.) Tl fH).

+  Tune Display (AZER) - 41 FF
SmartControl Premium 4 I .

*  Smartlmage - f Y ATRE: Off (K
M1 Text (LA + Office (04D
. Photo (H&JY) | Movie (3¢5
« Game (Jif%) + Economy (£3)

EEREXSEEHA
AR TAT 308 1 SmartControl
Premium EIFRIS, BT AALRER. R
eI A SN R T o
Find Windows  * |
Deskiop Partition
Tdentify Partition
Align Cn
Help
Techmical Support
Check for Update
About

I' Eit a

ESERE 5 M IE:

«  Help (FB) - Vil H A F Mt A
BRI Y 4% % 1147 IF User Manual (FH
FF stk

+  Technical Support (AR Z#F) - WoRHA
BRI

+  Check for Update (fe & EHT) - i H &
SKBIPDIF AL A2 75 A molt A o

¢ About (KTF) - WRTEHMMSH(F
PRI RATE R LR AR

« Exit (IBH) - XM SmartControl
Premiums,

QI FLIKIZAT SmartControl Premium, B3

M Program (#£/7 ) SEERHIEHE SmartControl

Premium, Bl Wit PC SLHIEI bR, B4

BB ARGt

SmartControl Premium

SmartControl
Version 2.10
dtune-plp-R2011-08-15-1133-18
Copyright ® 1993-2011 Portrait Displays, Inc.
Patents Pending

PHILIPS




EEREXEER

AE IR P A AT S5 R, N
IR Exit R ) 30, W#EAIRMTS54T
BLA MR SmartControl Premium, AT PLYE
Options>Preferences ( LT > 1L ) H4E
HH Run at Startup (JA3hINIE1T) o

e it

AT EORIUES . SmartControl

WAFRA A AR, AR ATIN ., TEEH
2B 5 1717 M3 www.portrait.com/dtune/

phl/enu/index PL %% SmartControl 4k {45
BIAS o
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4. EARAE

R AR AR AH-IPS LCD

Bt LED

TR 21.5"W (54.6 cm)

i fe b 169

BFE AR 0.2479(H) mm x 0.2479(V) mm
bl 250 cd/m?

SmartContrast 20,000,000:1

AL (38D 1000:1

W I JR] CL7R) 14 ms

SmartResponse I [i] (L) 5 ms(GtG)

A PR

1920 x 1080 @ 60 Hz

EREM

A 178° (H)/178° (V)@ C/R>10
SN AR 1670 Ji

BB 56 Hz - 76 Hz

SR ES 30 kHz - 83 kHz

MHL 1080P@30Hz

sRGB =

225C5QSB, 225C5QSW: VGA (140D . DVI ($7
HDCP)

J{EME

D A

f = 225C5QHSB, 225C5QHSW: VGA (Biftl) . HDMI (B
HDCP) . MHL-HDMI (¥, HDCP)

WANES BRI, Sha R

A 225C5QHSB, 225C5QHSW:  HDMI ¥ #itn

225C5QSB, 225C5QSW, 225C5QHSB, 225C5QHSW:

H P EERITE i< NY  ©/a B/ o
GO TR PRPEAOE. ANETE. PR ROKFNE. )

OSD = FIE fr 208 B E. EOUmEA T E. B, s,

o B dis ., ZR2siE, L HHAE . fEwE. B ctiE, fiikd

. Bk, HiE s

oAt A 12 Kensington 4

4 B FH e 1k DDC/Cl, sRGB, Windows 8/7/Vista/XP, Mac OSX, Linux

iRt 5/+20

225C5QSB, 225C5QSW:

7

‘

TAEREA

2221W (LAY | 2352W (k)

BEHR C(FFHLD

0.5W
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x 03W

FEYE LED 35747 TAERE: A, FRPL/ IEIRAE At (AR
FEV/ HNE, 100-240VAC, 50-60 Hz

225C5QHSB, 225C5QHSWV:

TAEREC 2134W (LAY | 2645W (k)
MER (FFHLD 0.5W

x 03W

HL 5 LED F87m4T TAEM: A, L/ RS At O
YA 4ME, 100-240VAC, 50-60 Hz
SIMERT

BEE

P GRJRRE) 294 kg

P (%) 47 kg

BITEYG

W (217D 0° C#J40° C

T . .

(rjﬁfj‘é%) 20° C#60° C

AR 20% %] 80%

MTBF 30,000 /N

ROHS =

EPEAT Silver (www.epeat.net)

[2h 1009 ] [H] i

KRB 100% PVC Jt BFR #L5%

Energy Star =

HE MR

I CE Mark, FCC Class B, CU, SEMKO, TCO Certified, ETL, BSMI,
5 1509241-307, CB, MEPS, SASO, KUCAS, EPA

P57

- 225C5QSW, 225C5QHSW: {1
2 225C5QSB, 225C5QHSB: A1,
EP S el
6 it
1. EPEAT Gold 8Y Silver {XAE Philips {1 77wt IR X A R A R IT 7 B K HB IX PR JMRIR B

V7 M www.epeatnet.
MR A AR, AURYIATIE AN . Vi) www.philips.com/support N i BT A 1) B AL T,
BIHE N A GG 5 GtG (BW) IR AE H i e 4

N

w
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41 DPFRITZELR

0 sXa#x
1920 x 1080 @ 60 Hz (RS A
1920 x 1080 @ 60 Hz (HUFHiA)
B #EEIHE
1920 x 1080 @ 60 Hz CErF4N)

KR PR ES EEINE

(kHz) (Hz)
3147 720 x 400 70.09
3147 640 x 480 59.94
35.00 640 x 480 66.67
37.86 640 x 480 72.81
37.50 640 x 480 75.00
37.88 800 x 600 60.32
46.88 800 x 600 75.00
48.36 1024 x 768 60.00
60.02 1024 x 768 75.03

63.89 1280 x 1024 60.02

79.98 1280 x 1024 75.03

55.94 1440 x 900 59.89

70.64 1440 x 900 74.98

65.29 1680 x 1050 59.95

67.50 1920 x 1080 60.00

6 it

TR, SR A LA A 4 R 1920 x

1080 @ 60Hz I T AR R B, ik B
WoRBOR, TEIEAG I T BRI o
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5. BIEEE

5 PC s T VESA DPM iz s Fuk
B, WoRE ] LIAEAE I A B
e, A E R A Mbroidty
WANERIEAN, BRI Esh MR .
;ji%ﬁéﬁﬁtﬁabﬁ HL I RE A DIRE R (5 5 1o
A

225C5QSB, 225C5QSW:

BREEEY

AKF | R . y
VESA # | HA % | FE MM | LED Bift

2221W (Ji7)

Tk e | & 2 (535w ) (SEN
REEAE S ’ SN
G Kl | w | 05w (i) D
PR KA - - 03W (JiL7) PR

225C5QHSB, 225C5QHSWV:

BIREEENY

vesa piat| wat | AT 1B | mmss | eo s

- 21.34W (J7)
TAE FE | 2 b 2%645W Uiy [EREN

BAEAI . " B
GEHL XK | ® | 05w (AD U
Kl K - - | o3w () PRIl

TR R T R AR R TR
o [ HER: 1920 x 1080

o XFELJE: 50%

o FLJE. 250 Bk

o {f: 6500k 4%

6 ik

WEAR AT AR, AT w4
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6. BXRAME

Congratulations!

This product is designed for both you and the

planet!
sustainable IT - manufacture,

use and recycling of IT products

reflecting environmental, social and economic
responsibility.

TCO Development works for

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for ICT products worldwide.

Some of the Usability features of TCO
Certified Displays:

*  Visual Ergonomics for image quality
is tested to ensure top performance
and reduce sight and strain problems.
Important parameters are Resolution,
Luminance, Contrast, Reflection and Colour
characteristics

*  Products are tested according to rigorous
safety standards at impartial laboratories

» Electric and magnetic fields emissions as
low as normal household background levels

*  Workload ergonomics to ensure a good
physical environment

Some of the Environmental features of TCO
Certified Displays:

*  Production facilities have an Environmental
Management System (EMAS or ISO 14001)

* Low energy consumption to minimize
climate impact

* Restrictions on Chlorinated and
Brominated flame retardants, plasticizers,
plastics and heavy metals such as cadmium,
mercury and lead (RoHS compliance)

*  Both product and product packaging is
prepared for recycling

* The brand owner offers take-back options

22

Corporate Social Responsibility

* The brand owner demonstrates the
product is manufactured under working
practices that promote good labour
relations and working conditions.

The Criteria Document can be downloaded
from our web site. The criteria included in

this label have been developed by TCO
Development in co-operation with scientists,
experts, users as well as manufacturers all

over the world. Since the end of the 1980s
TCO has been involved in influencing the
development of [T equipment in a more user
and environmentally friendly direction. Our ICT
product labeling system began in 1992 and is
now requested by users and |CT-manufacturers
all over the world.

For displays with glossy bezels, the user should
consider the placement of the display as the
bezel may cause disturbing reflections from
surrounding light and bright surfaces.

For more information, please visit:
www.tcodevelopment.com

I[u Technology for you and the planet
CERTIFIED

(Only for selective models)




Lead-free Product

Lead free display promotes
environmentally sound recovery
 and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated and
compliance with European community” s
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

EPEAT

(www.epeat.net)

&  The EPEAT (Electronic
Q@ Product Environmental
& Assessment Tool) program
evaluates computer
desktops, laptops, and monitors based on 51
environmental criteria developed through
an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste
EPEAT’ S requirement that all registered
products meet ENERGY STAR’ s energy
efficiency specifications, means that these
products will consume less energy throughout
their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

» EN60950-1:2006+A11:2009+A1:
2010+A12:2011 (Safety requirement of
Information Technology Equipment).

*  EN55022:2010(Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:2010 (Immunity requirement of
Information Technology Equipment).

+ EN61000-3-2:2006+A1:2009+A2:2009
(Limits for Harmonic Current Emission).

»  EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

* 2006/95/EC (Low Voltage Directive).

*  2004/108/EC (EMC Directive).

»  2009/125/EC (ErP Directive, EC No.
1275/2008 Implementing Directive
for Standby and Off mode power
consumption)

And is produced by a manufacturing

organization on 1SO9000 level.

*  1SO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

e GS EK1-2000:2011 (GS mark requirement).

»  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

e MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

*  TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(www.energystar.gov)

h As an ENERGY STAR® Partner, we

have determined that this product

meets the ENERGY STAR®
guidelines for energy efficiency.

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, I'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

+ Réorienter ou déplacer I’ antenne de
réception.

* Augmenter la distance entre
I’ équipement et le récepteur.

« Brancher |’ équipement sur un autre
circuit que celui utilisé par le récepteun

*  Demander |’ aide du marchand ou d’ un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiere de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

“This davice belongs to catagory B devices a8 described in EN 55022, unless it is spaci-
cally stated that it i a Class A devics on the epeciication labal. The following applies to
devices in Class A of EN 55022 (radius of protection up 1o 30 metars). The user of the
davice is obligad to take all staps necessary o remove sources of interfarance to tals-
communication or other devicas.

Pokd neni na fypovém &tk potstase uvedena, # spedé do do tidy A podie EN 55022,
spada automaticky do tfidy B podle EN 55022, Pro zafizen! zafazend do tFidy A (chranné
pésma 30m) podie EN 5502 platl nésleduficl. Dojde-li k rullan! telskomunikatich nebo
finjich zafizani e uivatal povinnen provést takova opatfgni, atry nen odstranil,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer; monitor, printer; and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/T-42107
and PN-89/E-06251.

Wymagania Polskiege Centrum Badan i Certyfikacji
Uzpedzenie powiano byt rasilane z paiasds 2 preylaceonym obwodem ochronmym (gnisedo
katkiem). Wapdipracuiaee 2 soby ufzadzenia (Komputer, monitor, drukarka) powinty bye msilane
& togo samego dridla
Instalacja elektrycna pomiesaczenia powinna mwie
przs zwarciami, w postaci bezpieconika o warke
W el catkowitogo wybyerenia urspdzents 2 siect zasilania, nalezy wyint wiycekg kabla
easilajacega = poazdka, kidre powinno ssidowad s w pobliz urmJJanm:I!\t Batwi dosiepne.
Znak bespieczefsrwa "B” potwierdzs 2podnosé uresdzenia » wymaganiami bezpiecsefaiwa
whytkowania awartymi w PN-93T-42107 | PN-§9E-D6;

w przeworksie fzowym rezecrowa achrang
marmienavwe] e wicksej ni 164 (amperiuw).

Pozostale instrukcje bezpieczensiwa

* Niemaledy urywad wiyceek sdapterowych lub usuwaé kolka abwedu ackrornego 2 wiyeeki.
Jekeli Lu\m‘WIILJLJ LRy |:|1:\:\Jlural‘ra o naledy whyd preediuzace 3-pylowego 2
System kmpalerowy rnlny sabezpivcryt prred nagtymi, chwilow
ac eliminatora preepied, urradrenia dopasow
berzakidceniowe irinia zasilania.

tic nie leZalo na kablach systemu kompuierowego, arz aby kable nie
dzse tokna byloby na sie nadeptywad lub poryksd sig o nie.

warostami lub spad-
X

T e p——

Nie maleiy wpychad adnych preedmiotion do atwost sy
podar lub porpenie pridem, poprzez o

najdowad sig 2 dala od g

Tacyjnych. Nakezy un

karmpuler oriz umisszezanss kamputera w ciasmym migse bez mailiwobe eyrkalac peoi-

plerwy i

etz wokdl niego.



North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILFORSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
RRZHENERIBE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schédden durch Rontgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerdtes befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Stérstrahlern nach Anlage
llla 5 Abs. 4 der Rontgenverordnung erflllt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf|
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhdhte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



EU Energy Label

lUWn‘ Labsed

[ Jeercgs)]

PHILIPS

]

The European Energy Label informs you on
the energy efficiency class of this product.
The greener the energy efficiency class of this
product is the lower the energy it consumes.

On the label, you can find the energy efficiency
class, the average power consumption of

this product in use and the average energy
consumption for 1 year

& Note

The EU Energy Label will be ONLY applied on

the models bundling with HDMI and TV tuners.
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China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products produced and sold for China
market have to meet China RoHS request.

A R LA SR s AR R IR R (P
ROHSYE M bR 7% BER) 7 il o A 55 A 5 40 o
TR AR R

AT IR0 3
235 a | ok | | Al | S| swoem
(Pb) | (Hg) | (Cd) | (Cré+) | (PBB) (PBDE)

shae o o o o o o
Wi R AT | X o o o o o
LR AL X o o o o o
L IHERLEE X o o o o} o
LR /R X [e] [e) [e] [e) o
L AR L DR o R R B S, B, L S0

B EERERRAE.
O: i Mwﬂ : mmf wwmwjmm I \JA'U'J(I CHLT A B
X 4R wdm(‘ﬂm*ﬁ* b SR (hFE

B AT AT DR R i (R R

) B R
X7 IR, A RKHIROHS IR (T4 oty

®

PRAE T IR

UERRARFE IR (458, 10 1A )™ P I 75

ﬁﬁ%ﬁﬁm?TEm&WM¢#T$AE¢%
SR HL A S A A S

&Aﬁﬂﬁﬁﬁﬁﬁm“jﬁEA% W7 3 1
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72 ERBRSSRE
A7 KA I M X DA 1 PR £ BTS2 SR, 34597 ) wwwiphilips.com/support 1o T

AAE R BT DLERET R T4 4 22 )R 25 e g% o L T
ARt X BB R IE B

Ex /[ #X ML S Bl et ]

Austria RTS +43 0810 000206 €0.07 Mon to Fri:9am - 6pm
Belgium Ecare +32 078 250851 €0.06 Mon to Fri:9am - 6pm
Cyprus Alman 800 92 256 Free of charge | Mon to Fri:9am - 6pm
Denmark Infocare +45 3525 8761 Local call tariff | Mon to Fri:9am - 6pm
Finland Infocare +358 09 2290 1908 | Local call tariff [ Mon to Fri:9am - 6pm
France Mainteq +33 082161 1658 €0.09 Mon to Fri:9am - 6pm
Germany RTS +49 01803 386 853  |€0.09 Mon to Fri:9am - 6pm
Greece Alman +30 00800 3122 1223 | Free of charge [ Mon to Fri:9am - 6pm
Ireland Celestica +353 01 601 1161 Local call tariff [ Mon to Fri:8am - 5pm
Italy Anovo ltaly [ +39 840 320 041 €0.08 Mon to Fri:9am - 6pm
Luxembourg Ecare +352 26 84 30 00 Local call tariff | Mon to Fri:9am - 6pm
Netherlands Ecare +31 0900 0400 063 € 0.10 Mon to Fri:9am - 6pm
Norway Infocare +47 2270 8250 Local call tariff [ Mon to Fri:9am - é6pm
Poland MSI +48 0223491505 Local call tariff | Mon to Fri: 9am - 6pm
Portugal Mainteq 800 780 902 Free of charge | Mon to Fri:8am - 5pm
Spain Mainteq +34 902 888 785 €010 Mon to Fri:9am - 6pm
Sweden Infocare +46 08 632 0016 Local call tariff [ Mon to Fri:9am - 6pm
Switzerland ANOVO CH | +41 02 2310 2116 Local call tariff [ Mon to Fri:9am - 6pm
United Kingdom | Celestica +44 0207 949 0069 Local call tariff | Mon to Fri:8am - 5pm

PEBRRER:

ExR/#X

Y

ERRSEIE

China PCCW Limited 4008 800 008
EXBKARER:

E=x / #X WY H s EPRSRIE
USA. EPl-e-center (877) 835-1838
Canada EPl-e-center (800)479-6696
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PR XK ARES

EZR / #X PEAY HRls EPIRS I

+37517 217 3386
Belarus NA IBA +37517 217 3389
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA MR Service Ltd +385 (01) 640 1111
Czech Rep. NA Asupport 420 272 188 300

+372 6519900(General)
Estonia NA FUJITSU +372 6519972 (workshop)
Georgia NA Esabi +995 322 91 34 71

+36 1 814 8080(General)

+36 1814 8565(For AOC&Philips
Hungary NA Profi Service only)
Kazakhstan NA Classic Service l.l.c. | +7 727 3097515

+371 67460399
Latvia NA ServiceNet LV +371 27260399
Lithuania NA UAB Servicenet :g;g ;47}0%%08186%%”8;2]?;)5)
Macedonia NA AMC +389 2 3125097
Moldova NA Comel +37322224035
Romania NA Skin +40 21 2101969
Russia NA CPS +7 (495) 645 6746
Serbia&Montenegro | NA Kim Tec d.o.o. +381 11 20 70 684
Slovakia NA Datalan Service +421 2 49207155
Slovenia NA PC Hand +386 1 530 08 24
the republic of Belarus | NA ServiceBy + 37517 284 0203
Turkey NA Tecpro +90 212 444 4 832
Ukraine NA Topaz +38044 525 64 95
Ukraine NA Comel +380 5627444225

BT EMEXBHKRER:

E%R / # X P RY Ly
Brazil

- Vermont
Argentina

& PR BiE
0800-7254101

0800 3330 856
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APMEA X EERIER:

ER /X ASP & PR BiE Bl g
Australia AGOS NETWORK PTY LTD 1300 360 386 Mon.~Fri. 9:00am-5:30pm
New Zealand | Visual Group Ltd. 0800 657447 Mon.~Fri. 8:30am-5:30pm
Hong Kong Company: Smart Pixels Hong Kong: Mon.~Fri. 9:00am-6:00pm
Macau Technology Ltd Tel: 852 2619 9639 Sat. 9:00am-1:00pm
gy L Macau:Tel: (853)-0800-987 7 ~EP
. Tel: 1 800 425 6396 .
India REDINGTON INDIA LTD SMS: PHILIPS 1o 56677 Mon.~Fri. 9:00am-5:30pm
+62-21-4080-9086 (Customer _ : An
donesia PT. CORMIC SERVISINDO | Hotline) :43?86_1T;T5’608'3O'1 200;
PERKASA +62-8888-01-9086 (Customer Fri'08'30'—11'30' 13:00-17:30
Hotline) T T :
Korea Alphascan Displays, Inc 1661-5003 g/la?n9~o'(:)2n2_('])ooa(;; —:]:30pm
Malaysia R-Logic Sdn Bhd +603 5102 3336 ?a‘t’”é;’;:'ﬁgfgi‘noo"m
Pakistan TVONICS Pakistan +92-213-6030100 Sun.~Thu. 10:00am-6:00pm
Philips Electronics Singapore =8 G _
Singapore Pte Ltd (Philips Consumer Care | (65) 6882 3966 ?ainé-oggﬁﬁ%énﬁ.oopm
Center) - P
Taiwan FETEC.CO 0800-231-099 Mon.~Fri.09:00 - 18:00
Thailand fg‘s Computer System Co. | 65y 934.5498 Mon.~Fri. 8:30am~05:30pm
South Africa | Computer Repair Technologies |011 262 3586 Mon.~Fri. 8:00am~05:00pm
Israel Eastronics LTD 1-800-567000 Sun.~Thu. 08:00-18:00
+84 8 38248007 Ho Chi Minh
FPT Service Informatic City 2R Gy ; :
Vietnam Company Ltd. - Ho Chi Minh | +84 5113.562666 Danang City [1\/]7090 522388__388 13:30-
City Branch +84 5113.562666 Can tho T '
Province
Sillplien || Ao SRl e (02) 655-7777; 6359456 Mon.~Fri. 8:30am~5:30pm
Solutions ,Inc.
Armenia
Azerbaijan
Georgia Firebird service centre +97 14 8837911 Sun.~Thu. 09:00 - 18:00
Kyrgyzstan
Tajikistan
Uzbekistan ﬁf d“'ko Plus Private Enterprise | o967+ 2784650 Mon.~Fri. 09:00 - 18:00
Turkmenistan | Technostar Service Centre +(99312) 460733, 460957 Mon.~Fri. 09:00 - 18:00
T4V T RAE=H— - B o .
Japan Fe B — 0120-060-530 Mon.~Fri. 10:00 - 17:00
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8.1 HEHKIE
NI EZE) SRR DN (7 T E1 P S e
TR LA LR M E T TSR A AE, TE S
Philips & F IR 45 AR RIKE R
[ 1 I
FZEE (BiELED ~%)
A0 LR 2 9 i ) 4 N, P A e R
TN G 1T
TG, R IE I A A A T
KL E, RIGHIEIEEIF R E
TEE (BE LD 2 rEfE)
ORI AL T FFHLRES
i RAs 5 2k IE A BT 5L
R Eon e e B Sk I IO ET .
FiAT, WG P A 4
T REEE T RED R
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Attention

Check cable connection

TR R S BERIER BT HNL.  (
N e VS UNE DI
R R S R 1A 25 A EL
R SNLAE TITH LRS-

AUTO (B3)) =EAEIER

« BA3hREAUEN T VCA-BHEE . N
PG5 RAM =, e Ll OSD 3¢
AT T i

6 i*

AUTO ( H3h) Uifig A& T DVI-Digital (DVI-

) B, R IZA AN T 2

B HIAE
DIDARATAEAT b o0 3R

B,
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] OSD Ff=lrh Setup (BEE)D Y
Phase/Clock CFHAZ/IN i) 4 €45 o7
B XA VGA R TREH .
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255 L 75 LA 2 [ 3 4 31 [
Mk PC.
BEERNERE

L T

{FH OSD TP “Auto (H
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i OSD F#= il Setup (&HE) 1

Phase/Clock (/M8 BRI 4. X
{AE VGA B R H
BKFERNERE

i OSD F#=HIH 1 “Auto (H
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o i OSD FE#HilH Setup (HE)D 1
Phase/Clock (/I8 BRI 4. X
{AE VGA F R AEH .

SlEY L P e N
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Jh,  CUREDT L “BRBT Bk “ERT &
B % o
BRI NF W50 5 S Bh () e
{RYFEFE
o WU BOR B R E EARAE
¥, 5506 3 FH B s R . FH R
o
FEANTIG R (AP R o B < U1
BN R, AR SEUT IR IS
TR B “ER IS, X%
WHEARSW S, WERBE. EiRifs)
AR ANLEARAETE R A
BgEH. XFE#.
H PC (1) ™ 5 HE R B s 2% B e (1)
EEER g7 2
RELIHNGES. 465, Kas. B
=l
IR 29 A8 0V R e AR 1 1 e
P, S G G DL T R TER
CHBEIR” KT, ST
BRI LG OSD E#erfild “isg”
) “HJE LED” SRS “Hiira " 45
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IRt — 3B, S WY S B
FZIFHE R Philips %/ IRGACE .

8.2 SmartControl Premium & I [g]
TR

B 1: HEEERFMA—A PC Pk
F % — PC i, SmartControl
Premium R TLEEH, EAM?
E%: TH/E3) PC, ¥ SmartControl
Premium & LAFIEH . &0, &

o EEM SR AR )5 FE T 4 3% SmartControl

Premium A 08 22 IE A (1) IR B 2
o

[B]&% 2: SmartControl Premium B T{EIE

®, BREARLE, BEAB?
BIE: WERPAT T R, AIREd S
B e Won A R o

Ve 2 o5 — AR 1 2
o TFTRSIR SRR T
o SHAERGALINTES, A service pack
oAb TR
IZ1T Windows Update FlI 58Ttk 7 % A1/
BRLSIK A R
TE Sk i S BT T (R 00 T I 8h T
Windows.
RERBNRIN, AR My Computer
(P, AR5 Bk Properties
(B> -> Hardware (fififf) -> Device
Manager (A& HIER) o
WRAE B Monitor CIERLES) RTH
L “Plug and Play Monitor (R[4 [ H
WoRdR) 7, MRS . R
SmartControl Premium, 4R J&5 87 22 23%
o

A8 3: ZIESE SmartControl Premium Jg,
B4 SmartControl Premium $5%
B, REREMEESEEREK
BEL, AftAa?

\Z: " REREKEIEER 2SS SmartControl
Premium ANFEA . 215 K G RL 25 A2
TR AR, TE S A
N2 ] R s LR E B R R &
FLAe IR AN FE T o 2R IRSFET . M
% SmartControl Premium, 4R )5 8
LRI
WRANARE TAE, WEIJEER A
%Y F. VI Philips Mk,
& A BT SmartControl Premium
IRENFRT o

B 4: ZHFEE Product Information ( 7=
miEE)H, RERHMMMEE, A
tar

EZ: TRE R KITE RIGRCAS IR P AN 2

BHROR, RIA 5643 R/ DDC/
ClEE T G MAH Y 2 =) P il

OB GG LA I ST
LHERSFET . MR SmartControl
Premium, #RJ5E B FT 22— IR,



Attention

Theft Deterence is Enabled

(@& 5: FKIIZT Theft Deterrence ( [
IhBE ) THRERI PIN. RAMN?
EE: 4T e RS MITAARL Philips ik
S BUESR P SVE S I A%
B

83 —fyE M) BfEE
WE 1 RERTEM, NRREELER

“Cannot display this video mode”
(TEEREAHHERX) , KE
AI?
BIE: @B BRa M F R 1920 x
1080 @60 Hz.

PR LA, RIER PC IR
RALHI (4 B7s 2 o

7E Windows “Start(FF4R)” S, ik
F “Settings/Control Panel(i5 /423 il i
1) o FePElEcE HHr . EFEDisplay
(27R) bR fEDisplay (f7)47 il Thi i
W, dEFE “Setting (B IR . 7E
PCEIEIR 1) “desktop area (M
DB 7 MESR, SR EUE £11920 x 1080
B,

«  #IFF “Advanced Properties (FiZf g tE)”
, FfRefresh Rate (Kll#i &) 460 Hz,
RS “OK” .

FHR AL, ARG EFHAT SR 2
A3 ARG PC BB AE 1920 x 1080 @
60 Hz.

KPHENL, W EORIN oR4s, R
HEEE Philips LCD R4«
TR R, AR5 H1IT PC Rl

BIER 2: iU LCD ERRERANRIFER
E20

B : Y LCD WoRas g% & 60
Hzo #5DE#e F I8, S
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AR ISR 75 Hz LUK 25 A 75 1
R/

B8R 3: & bR inf 0 icm SXEET4
A? WMIRERIERF (inf 0
iem) ?

m%: eARERERNSIEF . 1%

B4 User Manual ( M) H il
W BT SR — IR EEE R
R0, TN BE S T B B R AR IK
FEF Cinf Flicm SCPF) SOk B
A PSRBT g
BEMA, B aiET Cinf
il iem U ¥4 A3

B)E 4: AOfATEEE S AR ?

B2 BRI B IREN )P A B R4
SR T AR . e
1F Windows® Control Panel (453l
#2) (1) Display properties (g7 & M)

ST 0 H R

B 5: WERTHENTAEMTRIES
wh?

B Pl OKHkHl, AAIRIH Reset (32

fr) BRIy S 2 Jsan ) i

BIf 6: LCD REREHMEIE?
m&: s, SRS g

B, I HLN B AR s A
AT R T A WoR AR,
TN T iR . X AT RESY Y
Wi PRAE o

) 7: MaiE TS LCD RME?

BI%: TSRS T IE . 40
g, EHEHRAE. E2F
FE RS . AR A, ks

Fotbd sl
B 8: HAIMNENETRIABKRE
ng?

BIE: "Lk, &arLlsid OSD 4k ik
PR . RAUOBRATE:

o ¥ OKlk7r OSD (FiHehzm) SEif



% “Down Arrow (In] T #i3k)” it

“Color (Hift) 7 &I, K5tk OK 3k

ANFEEE, AT A EE.

1. ColorTemperature ( (i3 ): fuff 6
ANBEE, 4 5E 5000K, 6500K,
7500K. 8200K. 9300K il 11500K.
B AL S000K Y lH P IRy, itk b2
N CCBE, R A, MR
9 11500K B @7 “AE” , 2RI
[SRERT:

2. SRGB: X EHftRAEA W& (L
AL Woses. FTEDHL. X
S 2 IR IEA A B Y — R bR U

3. User Define ( /5 X ): H P BA
WL, SEFNE A, ML RE
H OB s

S it

AR N AT BT U (R 6 (1 e R P A
A DA AR ok Rk (JF/R %
O o BRI UL (U1 2004K) &40
B E R (i 9300K) s (m ., ik
FEM, 6504K,

BER 9: FKATLUBEEMNRRE RS EEE
PC. T{Euhgf Mac [3?
E%&: 2. CRIHRArE RS RS
PRUER PC. Mac A1 LAFuL 5843k
o B ERIRIER S Mac RGN,
ST — MR GE RS . B R
(s B, ES%M Philips #5

PRI
B 10: “WFiHR AR R AR A LA BDAERD A
2

EZ: ALl XU EIREE Windows 8/7/
Vista/XP/NT. Mac OSX. Linux F3Z

i B B DI RE -
B 11: B ERes AR R E G
ERIEMTA?

BIE AN ) AN ] W Al s i b s 1 £
A BE AR LI “HREDT B

*/J/z “ﬁ{%” Ez “E%” . “%EI’J “\
OB oSS WO AR,

ARE) P WIS ZHAEUT,
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KA R G, “JFED” L “H%
g7 o “HER” RBHTH K.
BRI NGE I 550 8 B s
BERARY FEY o
LR S CTRTAIS 3 bR TN | o e i
W, 105 5516 0t e 5 U 1
HIREFP .
25
A AN B A DR R B o e s ST
R, ATRESEU™ER) “RREN” . Bk
BR” B R R, KEPRIREAS
WK, WERBEE. BN HRAE
TRAZ G A -

B 12: At ARTRERETHXFAEE
W, ERMFHEREENR?
BIE: B onas £ SL A 20 5 1920
x 1080 @ 60 Hz It TAERC R et 4
PR ORI IR E

B 13: GRS/ BIEHAVAE?

E1%: %A &/0K 10 FHeia] / e
B Rl R

TR BUE IR, R EPTR.

Attention

Monitor controls locked

Attention

Monitor control unlocked

8.4 MHL FAQs
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UEAh, A T AL AT MHLIIE K 2k e TEEOR EoRER MR B s R

Z%%E*%&%o lé] E‘azl:E .
HRCIEBEIMALHOMUS 1, IR g i (3 s WL A,
A N EFEAR (RIS OSD) £ it ais ML 21200 25 7 T
IEFE T IER - . |

LN http://www.mbhlconsortium.org

SE7= i CIAMHLE 7 NIE . R
AR B, WRAE A FIMHL
BB BERT RSN, EZS WAL
&ig%?f%ﬁ%%%%&%%%ﬁ
BT

Attention

No video input(MHL-HDMI)

o TR IR BB ARIE AL (RN
Ao HOHEN, WoRht bain—400
KA E . —HRBZhs MR, B
s M JF BB
D SRS 1A 8 Y s R A A At v
o MNEFHHORIESE T IEFRHA

B 2. At ARTRERE LEGIERR
BRE ! ERNBHEE LBRREERR
iF.

EZ:

o MHUBRAEA S R N HI E SCAE R
1080p @30hz. MR RS FF AriZbnii o
BT I TR N WA
Ryt R (WHDE1080p), TR L i
IREE RS L IHDE1080p k. U
RSN R HE% (UQVGA), 1
BEFER IR Bl 4 b R AR v R A
U, AR R RS BoRA B AE 1 R i
FIRERLZE o

B 3. AR RFALHMES.

E%:

RS WoRss N EY S, HFHER
BB LR CITE.
Ab, AT U 0 1 B L.

TR SoRas A N B S, W
BRI (1 LA L 2 o g g
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